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This portion of the manual contains only the data recovery options of Recover It All 
Professional. Please see the help file included with both the demo and full version of the 
software for other Utility features. 
 
 
Recover It All Professional is a file system data recovery solution for almost all 
catastrophic instances of file and or data loss.  Whether files has been deleted, drive 
formatted, or file system corrupted, Recover It All Professional will help you recover 
your data. 
 
If you have any questions please do not hesitate to contact us at:  
 
URL:  
http://www.dtidata.com 
 
Phone: dial toll free: 1-866-438-6932 or direct 1-727-345-9665  
 
Email: 
For Sales: sales@dtidata.com  
For Support: support@dtidata.com  
 
Operating system requirements: 
Recover It All Professional runs in Windows NT/2000/XP.  However, you may recover 
any Win 9.x or ME by installing the drive as a slave or secondary drive under a Win NT 
4.0 system or higher. 
 

Quick Recovery 
 
 



Step 1:  Choose a Physical Drive 
 
Once you have executed Recover It all Professional (RIAP) you will notice a list of 
physical drives in the lower left hand corner of the screen.  Each line item will contain the 
data of "Phy ID", "Type", and "Size". Move the mouse cursor over the drive you wish to 
scan and 'double-click'.  The software will begin its scan for all valid 'partitions' or 
'logical drives'.  A red status bar will be seen across the bottom of the screen marking the 
scans progress. When the scan has finished the next step will be to choose a logical drive 
for recovery.   
 
NOTE: You may stop the physical scan at any time by clicking on the 'File' menu option 
and choosing 'Terminate Scan'. 
 
 
Step 2: Choose a Logical Drive 
 
When the physical scan has completed you will notice a list of 'logical drives' in the 
lower right hand quadrant of the screen. Each line item will contain the data of "Logical 
LBA",  "File System", and "Size".  Normally if you see a logical LBA of '63', that is the 
first logical drive on the physical drive.  In other words, it may very well be your 'C:\' 
drive.  
    
Move the mouse cursor over the logical drive you wish to scan and 'double click'  The 
software will then begin its scan for all directories and files.  You will notice a red status 
bar across the bottom of the screen.  This denotes phase one of the scan.  Once phase one 
has been completed a tan bar will start across the bottom of the screen.  This denotes the 
beginning of phase two. You may see several passes of the tan bar depending upon how 
many files you have, and how corrupt the file system has become.  Once phase two has 
completed a green status bar will start across the bottom of the screen.  This denotes the 
final phase of the file system recovery, or phase three.  When phase three has completed 
you will be presented with a directory structure in the center of the screen as well as a list 
of files in the current active directory on the right side of the screen.  The recovery in 
now ready for step three. 
 
Step 3: Select Files for Copying 
 
Now that the file system rebuild has been completed you may go through the 'treed' 
directories and look for the files you want to copy.  Next to each directory you will notice 
a small square.  By clicking on the square next to a directory you are marking all files, 
and sub-directories of the directory for copying.  If you wish to only copy certain files 
you may use the square next to each file name, then only those files will be marked for 
copying.   
 
There are times when you may only want certain file types to be marked.  If you want to 
recover Word files, or Excel files, or just a few 'JPG' files you may use the 'File Filter' 



menu option to help you. Once you have selected your files for copying it is time to move 
to the final phase of the recovery.  Step four. 
 
 Step 4: Copy Files 
   Copying files is a simple task. Simply click on the 'File' item of the 
menu bar.  Once that is displayed you will notice two menu items, one the offers 'Copy 
Marked Files w/Directories' and the other 'Copy Marked Files Flat'.  The first item will 
copy the files and keep the directory structure intact.  The second item allows you to copy 
files without any directory structure.  This could be used for just a few files, however it 
needs to be noted that if files are copied from different directories you may have 
duplicate file names.  If this occurs then the software will append a numeric value to the 
file name.   
 
Once you have chosen the method of transfer you will be presented with a browse 
window.  Use this window to choose which drive, and which directory to send the 
recovered files too.  You will also have the option to create a directory to send the data to.  
This method is highly recommended.  After you have chosen the drive and directory 
destination the purple status bar will begin its march across the bottom of the screen.  
You will also notice as each file is copied the file name will be displayed in the status 
window as well as an orange progress bar to mark the files copy status.  Once the purple 
status bar has reached the end the recovery is finished. 
 
NOTE: Do not copy the recovered files to the damaged drive, it will only damage the file 
system even more as well as corrupting any data on the drive. 
 
 There is no way to ensure that the data you have recovered is in fact 'good'.  There 
are many factors that can in fact, corrupt data.  Viruses, operating system, faulty 
hardware, and a hundred and one more things can cause your data to corrupt.  In order to 
help you make some type of determination on whether your particular set of data may be 
corrupt the software has a 'Verify Integrity' function that will peruse the current listed file 
structure and find data anomalies.  All data that the software encounters that may be 
corrupted will be highlighted in red text. 
 

Fast Logical Scan 
 
 
The fast logical scan is the function you should use to recover deleted files.  If the drive 
has been formatted, the file system corrupted by virus or operating system anomalies, or 
you just can't see your files then use the Slow Logical Scan  to recover your data. 
  This scan peruses the active file system and has a very high rate for 
recovery.  In other words, if you perform this scan, and you see your files there is an 
excellent possibility that you will be able to retrieve the data.  However, there is never a 
guarantee that you will be able to retrieve your data and it should be noted that the NTFS 
file system has a much higher recovery rate than FAT file systems. 
 



After performing a fast scan the directory tree structure may be such that the files you are 
looking for are not in their proper directories.  Although this happens more in a slow 
logical scan there is the possibility that you may see it here. If this is the case, then use 
the File Filter menu option to help you find where the lost files have been placed.  The 
tree will also display an 'Unlinked Data' and an 'Orphan Files' directory. Many times you 
can find your files in these directories. 
 

Slow Logical Scan 
 
 
The Slow Logical Scan enables recovery from drives that have been formatted, file 
systems corrupted, or where the data cannot be viewed from a Fast Logical Scan.  The 
slow scan takes a thorough look at the entire drive and not just the current active file 
system.   
  After a slow scan the directory tree structure may be such that the files you 
are looking for are not in their proper directories.  If this is the case, then use the File 
Filter menu option to help you find where the lost files have been placed.  The tree will 
also display an 'Unlinked Data' and an 'Orphan Files' directory. Many times after a slow 
scan you can find your files in these directories. 
 
The slow scan option is the last resort for recovering your data.  If after executing a slow 
scan you cannot see your files then this software will not be able to help you. 
 

Recovery Status Window 
 
 
Throughout the recovery there are several milestones that the software reaches.  Each one 
of these milestones is an integral part of the recovery.  In order to facilitate a 
comprehensive monitoring of each recovery stage a small 'Recovery Status'  window has 
been made available.  The following is an explanation of each status line item. 
 
 
· LBA: This item denotes which raw drive sector is being currently analyzed.  LBA 
is an acronym for Logical Block Addressing which is defined as viewing the drive in a 
linear state in contrast to a Cylinder-Head-Sector geometrical view. 
· T-Rem: During certain drive analyzing periods there may be a long time lapse, T-
Rem or Time Remaining will display the amount of time until this particular stage is 
finished. 
· Rd Err: If you are currently analyzing a drive that may have bad media this item 
will help convey that.  Rd Err or Read Error tracks how many bad sector reads were 
encountered during a recovery. 
 



· T-Dirs: After a physical scan has been completed the next step is to execute a 
logical drive scan.  During the logical scan the software will encounter valid or 'intact' 
directories. The T-Dirs or Total Directories item displays this information. 
· T-Files: After a physical scan has been completed the next step is to execute a 
logical drive scan.  During the logical scan the software will encounter numerous files. 
The T-Files or Total Files item displays this information. 
 
· M-Bytes: Once the logical scan has been completed it is time to peruse the 
displayed file system and decide which files you want to recover.  As each File/Directory 
is marked the M-Bytes of Marked Bytes indicator displays the total bytes currently set for 
copying. 
· M-Bytes: Once the logical scan has been completed it is time to peruse the 
displayed file system and decide which files you want to recover.  As each File/Directory 
is marked the M-Files of Marked Files indicator displays the total files currently set for 
copying. 
 

Copying Files 
 
 
Once the file system rebuild has been completed you are presented with a directory tree 
structure.  Next to each directory you will notice a small square.  By clicking on the 
square next to a directory you are marking all files, as well as  any sub-directories of  the 
current active directory. If you wish to only copy files and not entire directories you may 
use the square next to each file name. By clicking on the file square and not the directory 
square you only mark those files.   
 
There are times when you may only want certain file types to be marked.  If you want to 
recover Word files, or Excel files, or just a few 'JPG' files the 'File Filter' menu option 
will help you. Once you have selected your files for copying it is time copy them. 
 
Copying files is a simple task. Simply click on the 'File' item of the menu bar.  Once that 
is displayed you will notice two menu items, one the offers 'Copy Marked Files 
w/Directories' and the other 'Copy Marked Files Flat'.  The first item will copy the files 
and keep the directory structure intact.  The second item allows you to copy files without 
any directory structure.  This could be used for just a few files, however it needs to be 
noted that if files are copied from different directories you may have duplicate file names.  
If this occurs then the software will append a numeric value to the file name.   
 
When you have chosen the method of transfer you will be presented with a browse 
window.  Use this window to choose which drive, and which directory to send the 
recovered files too.  You will also have the option to create a directory to send the data to.  
This method is highly recommended and a directory name of "Recovered Data" could be 
used.  After you have chosen the drive and directory destination a purple status bar will 
begin its march across the bottom of the screen.  You will also notice as each file is 
copied the file name will be displayed in the status window as well as an orange progress 



bar to mark the files copy status.  Once the purple status bar has reached its end the copy 
is finished. 
 
NOTE: Do not copy the recovered files to the damaged drive, it will only damage the file 
system even more as well as corrupting any data on the drive. 
 

Saving and retrieving drive scans 
 
 
There are times when a scan seems to take forever.  They can last for hours, sometimes 
days depending upon the size of the drive as well as the damage to the file system.  In 
order to keep from having to rescan the drive either because you are using the demo, or 
you need to change some things on the system and try another approach, there is a way to 
save the ACTIVE scan.  An ACTIVE scan is designated as one where you have scanned 
one of the LBA listings on the right side of the main dialog box and a list of folders and 
files are displayed. Those folders and files are then ones saved. There may be multiple 
LBA drives listed, but only the one currently listing files and folders are saved. 
 
In order to SAVE a scan just go to the main menu title 'File' and click on 'Save Current 
Scan'.  You will be presented with a dialog box that allows you to pick the folder where 
you want the file saved.  The file name is 'Save Scan.dti' and cannot be changed.  If you 
have multiple scans you want to save without overwriting the previous save then make a 
new folder  and place the new scan in there. 
 After you have chosen the folder, the data will be written to the hard disk.  The 
'Save Scan.dti' file may become very large (10 mb or more) so make sure you have room 
on the drive.  Also, never write a saved scan to the drive you are trying to recover. 
 
In order to SAVE a scan just go to the main menu title 'File' and click on 'Load Scan'.  
You will be presented with a dialog box that allows you to  choose the saved file.  Once 
you have chosen the file it will be loaded into the software and become the ACTIVE 
scan.  All other LBA drives listed, as well as any ACTIVE scan will be deleted in 
preference to the loaded saved scan.  In other words. if you have a scan that you don't 
want messed with, don't load a saved scan.  You will know that you have had a successful 
load by the LBA listing displaying the text (SAVED) after the file system designator. 
 
This function is pretty easy to use, just remember where you saved the original scan so 
that when you go to load it won't be lost. 
 

Verify Integrity menu option 
 
 
Although there is not a 'fool proof' method for ensuring the files you see within the 
current active directory structure are in good shape, there are some things that can be 



checked to alert you to bad data.  By utilizing the 'Verify Integrity' option of the software 
you can get an indication of the data corruption you may or may not be experiencing. 
To use the function just click on the menu option 'Verify Integrity' and highlight 'Verify 
Selected Files'.  Click on that function and the software will scan each marked file for 
data inconsistencies.  If through the AI testing of the software a data problem is detected 
then that file, and all related files will be marked as 'corrupt' and be displayed in red. 
 
NOTE: Although files may be marked in red and may be corrupt it is only the software’s 
'best guess' as to the state of your data.  Conversely, if a file is displayed as blue it does 
not necessarily mean that the data is in a 'usable' state. 
 

Find Files From an ACTIVE Scan 
 
There may be times when you only want to recover certain types of files.  You may have 
important Word files, or perhaps some Excel spread sheet files, or just s few pictures that 
you have fond memories of and cannot be replaced.  If this is the case then the 'Find Files 
From an ACTIVE Scan' option will help you.  Click on this option and a dialog box will 
appear. 
     
The finder has two modes of operation, pre-set file types, and user defined. The pre-set 
mode is a set of options that will encompass certain groups of file types.  For instance, 
'Graphics Formats'  will include 'jpg', 'bmp', 'gif', and 'tiff' files.  Each file grouping will 
have a few of the file types in it and will make it easier for you to select.  If, however, 
you have a specific file type, or the group files does not have your file format then you 
may enter the type you are looking for.  As an example you may type in '*.mdf', *.mdb", 
"*.ldf", and '*.ldb" in order to find all database files for SQL Server.  The format for this 
is *.mdf, *.mdb, *.ldf, *.ldb.  Just remember everything is comma delimited. 
 
The next step is to "Find Selected File Types" under the "File" menu item.  This will scan 
the ACTIVE directory structure and match all files that meet your criteria.  As each file is 
found it will be placed in a list on the finder dialog window. It will also be marked on the 
main user screen.  A maximum of 2000 files will be listed in the finder dialog window, 
but all files found will be marked on the main list. 
 
Once all the files have been found and placed in the list you may then mark any files you 
want for transfer by clicking on the box next to the file name.  If you want to mark all the 
files for transfer just use the "Mark All Files" option under the "Options" menu item. 
Once you have marked all of the files you wish to transfer you may then "Copy" them to 
a directory. 
 
To copy the files just use the "Copy Marked Files" item under "File 
" on the main menu bar.  A window will pop-up and allow you to choose the directory 
you wish to copy the files too.   
 
****** NOTE ****** 



 
THE FILES WILL BE COPIED TO THE DIRECTORY WITHOUT A DIRECTORY 
STRUCTURE.  ANY DUPLICATE FILE NAMES WILL HAVE A NUMBER 
APPENDED TO IT. 
 
You may stop the copy at any time by using the "Stop Copy" item under "File" on the 
main menu bar. 
   
This option is for those who have a few files and do not want to have to scan the entire 
file structure looking for them. 
 

Build Boot Record 
 
 
The boot record is one of the keys to initializing the operating  system.  If this 
cornerstone has somehow been corrupted, or you are receiving error messages such as 
'No operating system found.", then this little utility may be the answer to your dilemma. 
A word of caution here.  This function will WRITE data to sectors of the hard drive. 
Anytime that a write is performed there is a possibility for more corruption, so use this 
function only in emergencies. However, if you have nerves of steel and are willing to 
sacrifice all, then by all means, read on and enter the dark steamy plane of boot record 
creation... Muahahahahahaha!!! 
 
Under the "Utilities' menu option click on the menu item which displays 'Build Boot 
Record'.  You will be presented with a dialog box, very similar to the one you are 
viewing now. 

 
 
 There are several fields that need some explanation.  They are as follows. 
 



 LBA Sector: 
  This field contains the sector where the boot record is to reside.  On a 
single partitioned drive the is normally 63, however placement of the boot record depends 
upon how the drive has been partitioned, is there as diagnostic partition, is this the 
primary boot partition, and many other factors too numerous too mention here. 
 
Total Sectors: 
  See  and read the explanation for the Total Sector entry.  It will give you 
an idea of how to calculate the partition size. 
 
 Start Cluster: 
  This field is two fold depending upon the file system you are currently 
working with.  If you are using a FAT32 type file system then this field will hold the start 
cluster for the FAT table.  Although this is normally '2' it is dynamic and can give you a 
headache.  If you are fortunate enough to be working on an NTFS file system then the 
values could either be '4' or '786432'.  The latter is not an arbitrary number but has 
something to do with the fact that its hex counterpart is displayed as 'C0000' which kind 
of looks like 'C0000L', which might be a little Microsoft engineer joke.  Who knows?  
Anyhoo, those are the two normal values, however, once again this is a virtual value and 
can be anything especially if this is a converted file system. 
 
Sectors Per FAT: 
  You're on your own on this.  Hopefully you will have some fragment of 
data that can tell you how to do calculate FAT size.  Just remember there is almost 
always 2 FATS, so whatever the FAT size is, the double it and put that value in the field.  
If this value is incorrect, then the entire partition will be skewed since the first cluster 
starts at the end of both FATS.  Good luck! 
 
 Sectors Per Cluster: 
  Under an NTFS file system this value is almost always 8, unless the file 
system was converted from FAT32, then the value is usually '1'.  Under a FAT file 
system this is one of the following values 1, 2, 4, 8, 16, 32, 64, 128, 256.  Always a 
multiple of 2.  Cluster size is in direct relation to Total Sectors, and the FAT size is in 
direct relation to the cluster size.  Conversely, the knee bone is connected to the leg bone, 
and the leg bone is connected to the thigh bone. But, I digress.  
 
Now that we have all of the fields filled in, we can send our boot record to the hard drive 
and create mayhem beyond compare.  Just click on the 'Write' button.  You will receive a 
warning telling you that you are writing to the hard drive and doing so may stunt your 
growth.  Ignore said warning if you TRULY want to write the boot record. 
 
 That is it for this particular utility.  If you have any questions, please feel free to 
call tech support.  They love it when I put that in the documentation!!! 
 



Build Partition Record 
 
 
There are times when the software may not recognize the correct partitioning of the drive.  
This may be due to a virus overwriting the original partition record, an accidental 'fdisk', 
operating system anomaly, software anomaly or a plethora of other causes that would 
boggle the minds of lesser men.  However, we have a solution that will bring a smile to 
your face and possibly your data online.  A word of caution here, this function will 
WRITE data to sectors of the hard drive. Anytime that a write is performed there is a 
possibility for more corruption, so use this function only in emergencies. If, however, you 
are stout of heart and spirit, then by all means, read on... grasshopper. 
 
Under the "Utilities' menu option click on the menu item which displays 'Build Partition 
Record'.  You will be presented with a dialog box, not unlike the one you are viewing 
now. 

 
 
 There are several fields that need some explanation.  They are as follows. 
 
 Start Head, Start Sector, Start Cylinder: 
  These three fields are the starting delimiter for the partition.  On a single 
partitioned drive the normal parameters are 0, 1, 0 respectively.  That is, start head 1, start 
sector 1, start cylinder 0.  You will use this most of the time unless you have some type 
of diagnostic partition, boot handler, or the partition lies along the nether regions of the 
drive. 
 
End Head, End Sector, End Cylinder: 
  These three fields are the other side of the coin, or the ending delimiter for 
the partition.  On a single partitioned drive the normal parameters are 254, 63, 1023 
respectively.  That is, end head 254, end sector 63, end cylinder 1023.  Once again you 
will use these most of the time unless you have some type of weird inverted, upside down 
sideways configuration which would change the sector, or head count.  One note here, the 
ending head will never exceed 254, the ending sector will never exceed 63, and the 
ending cylinder will almost never exceed 1023, NT 4.0 not withstanding. 



 
Reserved Sectors: 
  This fields value is the total sectors from the partition record to the boot 
record, where the boot record is considered the actual beginning of the partition, 
otherwise known as the logical drive. On a single partitioned drive this is normally 63 
sectors. If you have a multi-partition drive this value will vary greatly. 
 
 Total Sectors: 
  This field is somewhat self explanatory, however, I will give you the 
following formula to use when calculating the proper total sectors. For an 80 gigabyte 
drive the total sectors on the drive is 167772160.  However some drive manufacturers do 
not use the standard 1048576 bytes per megabyte as a basis for their drive calculations.  
the will say that 1000000 bytes equals one megabyte, and therefore when looking at the 
capacity of their drives they will seem larger than the really are.  Haven't you ever 
wondered why you were sold an 80 gigabyte drive but windows properties shows it as 
anywhere between 74 and 76 gigabytes. You know now the reason why.  The secret is 
out, the genie has escaped the bottle, and I am now the pariah of the hard drive industry.  
To properly report the total sectors on a drive partition you multiply the heads, times the 
sectors, times the cylinders minus the reserved sectors. So, on an 80 GB hard drive the 
heads would be 255, the sectors would be 63 and the cylinders would most likely be 
10443.  That gives your 167766795 sectors, minus the 63 reserved sectors or a final tally 
of 167766732 sectors for a single partitioned drive.  Simple?  Not!  I suggest you call 
tech support for help on this. 
 
LBA Sector: 
  This field connotes where to place you newly configured partition.  On a 
single partitioned drive the LBA sector will be 0. 
  
 Bootable: This little check box is very important.  Without marking the partition 
as bootable the boot code will not execute, and your computer will just hang as if it were 
waiting for a light to turn green.  However, only mark the partition bootable if it is the 
primary, and boot partition. 
 
 Now that we have all of the fields filled in, we can send our partition to the hard 
drive and etch it onto the medium so that all will know that we have been there.  Just 
click on the 'Write' button.  You will receive a warning telling you that you are writing to 
the hard drive and doing so may cause a preponderance of maladies including ring worm 
and the creeping crud.  Ignore said warning if you TRULY want to write the partition. 
 
That is it for this particular utility.  If you have any questions, please feel free to call tech 
support. 
 
 
Legal Notice: Recover It All is a Trademark of dtidata.com, Inc. All other Trademarks 
are property of their respective owners. Copyright dtidata.com, Inc, 2004. 


